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1 Introduction

11 About this document

In many cases problems or errors witnessed with OPUS have been accepted, and it
has been tried to somehow get on with them. However, this attitude does not help to
improve the general situation nor solves the specific problem.

Therefore, report any single problem, error or OPUS system crash to the Bruker
Optik software department. New ideas and suggestions for improvement are also
welcome.

For important information this document uses the following format:

The i provides important information given to the user to facilitate troubleshooting in
specific application issues.

(WP

1.2 How to report errors?

» Send an e-mail to: opusbugs@bruker.com
» Use the official OPUS error form available in the intranet (only internal):
file://pia.optik.lan/Home/Groups/QM/Formblaetter/IRENS/FBSOI008.doc

1.3 Mandatory items to be reported in any case

» Exact OPUS version, including date
* Operating system version
» Detailed description of the last steps which have been done or tried to do

Bruker Optik GmbH OPUS Error Reporting 5
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14 Further items to be reported

Depends on the complexity of the problem. Several different types of problems or
errors are distinguished:

1.  Complete operating system crash

OPUS crash

OPUS disappears

Error message in OPUS

OPUS interface freezes

ok wbd

The different types of problems or errors which may occur in connection with OPUS
and their troubleshooting are described in chapter 2.

1.5 How to log errors in Windows 7 or 10

Any type of crash occurred in OPUS is generally logged by the Windows Error
Reporting (WER) program. So-called dump files, which are more or less reports of
what happened to the system at the moment before it failed, allow to save program
information in the dump file, which can be useful for a later debugging. The dump
file uses the minidump file format with the *.dmp file extension.

If OPUS crashes and prior to its termination, the WER checks the dump file entries
in the registry1 to determine whether a local dump is to be generated. In the affirma-
tive, OPUS is terminated after the dump file has been generated.

These dumps are configured and controlled independently of the rest of the WER
infrastructure. You can make use of the local dump collection even if WER is dis-
abled or if the user cancels WER reporting. The local dump can be different to the
dump sent to Microsoft.

1. Windows database in which all pieces of information on software and hardware are stored.

6 OPUS Error Reporting Bruker Optik GmbH
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1.5.1 Defining WER as default program

Defining WER as default program for logging errors requires Administrator user
rights.

jund

Open the Windows Start menu.

Select the Run command.

On the dialog that opens, enter regedit.

Click OK to confirm.

Select the following path for the registry parameters:

> HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Windows Error
Reporting\LocalDumps

6. Enter the registry parameters described in chapter 1.5.2.

ok 0N~
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1.5.2 Registry parameters for global settings

Value Description Type Default value

The path where the dump files are to
be stored. If you do not use the
default path, the folder must contain
ACLs that allow the crashing process
to write data to the folder.

For service crashes, the dump is
written to service-specific profile fold-
ers depending on the service
account used.

For example, the profile folder for
system services is:
%WINDIR%\System32\Con fig\Sys
temProfile

For network and local services, the
folder is: %WINDIR%\ServicePro
files

REG_ %LOCALAP
EXPAN PDATA%\
D_Sz Crash-Dumps

DumpFolder

The maximum number of dump files
in the folder. When the maximum
DumpCount value is exceeded, the oldest dump
file in the folder is replaced by the
new dump file.

REG D

WORD 10

Table 1.1: Registry parameters for global settings
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Value Description Type Default value
Specify one of the following dump
types: 1
+ 0: Custom dump REG_D
D T =
umpiype + 1: Mini dump WORD
* 2: Full dump 2
The custom dump options to be MiniDumpWithData
used. This value is used only when Segs |
Custom-Dump DumpType is set to 0. The options REG_D | MiniDumpWithUnlo
Flags are a bitwise combination of the WORD aded-Modules |
MINIDUMP TYPE? MiniDumpWithProc
— b
enumeration values. essThreadData
Table 1.1: Registry parameters for global settings

a. http://msdn.microsoft.com/en-us/library/ms680519(v=VS.85).aspx
b. In hex, this is the value 0x121.
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1.5.3  Registry parameters for application-specific settings

Application-specific registry parameters override the global settings. To create appli-
cation-specific settings, you have to create a new key for your application
(chapter 1.5.3.1 or 1.5.3.2).

jud @

1.5.3.1 Creating key in case of OPUS 8 or >8

Open the Windows Start menu.

Select the Run command.

On the dialog that opens, enter regedit.

Click OK to confirm.

Select the following path for the registry parameters:

> HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\Windows Error
Reporting\LocalDumps\OpusCore.exe

6. Add the dump settings under the OpusCore.exe key.

> [f OPUS crashes, WER first reads the global settings, and then overrides
any of the settings by using the application-specific settings.

a bk wbd =

1.5.3.2 Creating key in case of OPUS 7.8 or <7.8

Open the Windows Start menu.

Select the Run command.

On the dialog that opens, enter regedit.

Click OK to confirm.

Select the following path for the registry parameters:

> HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\Windows Error
Reporting\LocalDumps\opus.exe

a bk wbd -~
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6. Add the dump settings under the opus.exe key.

> |f OPUS crashes, WER first reads the global settings, and then overrides
any of the settings by using the application-specific settings.

1.6 How to log errors in Windows XP?

Any type of crash occurred in OPUS is generally logged by Dr Watson. In some
cases, however, other Windows programs are used to log system crashes. Win-
dows XP, e.g. can be configured such that the Windows Error Reporting (WER) pro-
gram acts instead of Dr Watson.

In this case, a typical Windows error message pops up. It is possible to define Dr
Watson as standard to trace errors in the form of so-called log files. The steps
required are described in chapter 1.6.1.

1.6.1  Defining Dr. Watson as log file standard

Open the Windows Start menu.

Select the Run command.

On the dialog that opens, enter drwtsn32 -i.
Click OK to confirm.

> A message pops up. The message confirms that Dr Watson has been
installed as standard program to create log files.

5. Click OK to confirm the message.

Pobd =
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1.6.2 Error messages in Windows

1. As soon as the error message is displayed, open the error report.
> The error processing is sent to Dr Watson which generates the correspond-
ing log files.
2. Make a screen shot of the error report contents.
3. Send the screenshot to opusbugs@bruker.com.

> Do not send the \accomp.txt’ file to Bruker, as this file does not contain any
usable data.

12 OPUS Error Reporting Bruker Optik GmbH



2 Types of errors

The following chapter describes the different types of problems or errors which may
occur when working with OPUS.

21 Complete operating system crash
What happens? Blue screen
Possible cause: » Severe problems with the operating system

» Perhaps a non-conforming driver

What about OPUS? OPUS probably does not cause this problem
as it is a user-mode program.

Information on the error: * Look at the first two lines on the screen
(mainly figures).

» Look at the DLL list, written right below
Name.

» Check drivers recently changed, or new
hardware components.

* Remove drivers or look for more updated
ones by contacting the vendor.

Table 2.2: Complete operating system crash
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2.2 OPUS disappears

What happens? * OPUS completely disappears from the
screen.

» Even the OPUS process disappears from
the Windows Task Manager.

Possible cause: » Any problem with the PC configuration
» So-called Silent Process Exit:

- normal, planned (and silent) exit, due to a
normally executed (yet possibly unex-
pected) exit request for a component used
within the OPUS process

- abnormal exit (silent!), due to an unrecov-
erable multi-error problem

* Interaction with other programs

Information on the error: No information available at all, not even a
message box notification.

What is to be done? » Contact Bruker software department to clar-
ify whether additional debug tools can be
used.

» Download the debugging tools for Windows
(e.g. gflags.exe) from the following Microsoft
Web site:
http.//www.microsoft.com/whdc/dev
tools/debugging/instalix86.mspx

* In case of Windows 7 and higher: activate
the Silent Process Exit option; or configure
an interactive debugger, e.g. via windbg -/

Table 2.3: OPUS disappears

14 OPUS Error Reporting Bruker Optik GmbH


http://www.microsoft.com/whdc/devtools/debugging/installx86.mspx
http://www.microsoft.com/whdc/devtools/debugging/installx86.mspx

Types of errors 2

Background information: Very often the hang only occurs when the pro-
cess is under load. The best approach is to
attach a debugger to the process after it has
hung (if you can reproduce the problem or
remote debug), or create a process dump.

A process dump is almost as good as a live
debug in these cases, as the state does not
change much over time; that is as good a defi-
nition of a hang as any other one.

Table 2.3: OPUS disappears

23 Error message in OPUS

What happens? OPUS still runs. Error message pops up.

Possible cause: » Any temporary OPUS system error
» Wrong procedure sequence
* Missing files or methods

Information on the error: Text written in error message
What is to be done? Send a screenshot of the error message to:
opusbugs@bruker.com

Table 2.4: Error message in OPUS
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2.3.1  Error message in connection with ADIO/PROCESS

What is to be done? Send the ADIO/PROCESS protocol log files
to opusbugs@bruker.com.

ADIO/PROCESS log file + ADIO: <OPUS\ADIO\error.log
path: * PROCESS: <OPUS\PROCESS\ProcessS
cenarioSequence.obs\error.log

Table 2.5: Error message in OPUS

2.4 OPUS interface freezes

What happens? OPUS does not react to any data input at all.

Possible cause: Several actions running too fast in succes-
sion.

Information on the error: No information available.

What is to be done? » Wait at least 2 minutes to reverse this

hang-up. Try to minimize the window. Maxi-
mize again to see whether the spectra dis-
play has been refreshed.

« If the hang-up still persists, open the Win-
dows Task Manager to have a look at the
programme status. End task, if required.

» Send a short description of the situation to
opusbugs@bruker.com.

Table 2.6: Error message in OPUS
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241 Creating dump file for a hanging process

2411 In case of Windows 7 or 10 using OPUS 8 or >8

-_—

Right click the taskbar.

From the pop-up menu that opens, select the Start Task Manager (Windows 7)
or Task Manager (Windows 10) command.

Click the Processes (Windows 7) or Details (Windows 10) tab.

Right click the OpusCore.exe entry.

From the pop-up menu that opens, select the Create Dump File command.
Wait until the data are written into the dump file.

If the OpusCore.DMP dump file has been created, click OK to confirm the mes-
sage box.

> The message box shows the directory which the dump file has been saved
in. Dump files have the extension ™*.DMP".

N

No o bk w

2.41.2 In case of Windows 7 or 10 using OPUS 7.8 or <7.8

1. Right click the taskbar.

From the pop-up menu that opens, select the Start Task Manager (Windows 7)
or Task Manager (Windows 10) command.

Click the Processes (Windows 7) or Details (Windows 10) tab.

Right click the opus.exe entry.

From the pop-up menu that opens, select the Create Dump File command.
Wait until the data are written into the dump file.

If the opus.DMP dump file has been created, click OK to confirm the message
box.

N

No o ko

> The message box shows the directory which the dump file has been saved
in. Dump files have the extension "™*.DMP".
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2.4.1.3 In case of Windows XP

The Userdump.exe auxiliary tool is required. Details on the Userdump.exe auxiliary
tool are described in the Userdocs.doc file. The file is part of the auxiliary tool.

1. Download the Userdump.exe tool, version 8.1 (including the related documen-
tation) from the following Microsoft Web site:

> http.//www.microsoft.com/download/en/search.aspx?q=Userdump.exe
2. Start the Setup.exe program for the processor.

> By default, the ‘Setup.exe’ program is part of the "Userdump.exe’ tool in the
'C:\kktools\user dump8.1’ folder. The ’'Setup.exe’ program installs a ker-
nel-mode driver and the 'Userdump.sys’ file. Additionally, the program gen-
erates the 'Process Dump’ icon in the ‘Control Panel'.

3. If possible, deactivate the Dump on process termination feature when the
Setup.exe program runs.

4. If the program stops responding, go to the Userdump.exe tool.
5. Select the command line and enter the userdump <PID> command.

> <PID> is a placeholder for the process ID (PID) of the program that has
stopped responding. To obtain the PID of the program, open the Task Man-
ager, and click the ‘Process’ tab.

6. Start the userdump <PID> command.
> A file is generated with the **.dmp’ extension.

7. Send the *.dmp file to opusbugs@bruker.com, to perform post-mortem debug-
ging.

18 OPUS Error Reporting Bruker Optik GmbH


http://www.microsoft.com/download/en/search.aspx?q=Userdump.exe

Types of errors 2

2.5 Windows XP

2.5.1 OPUS crash

What happens? OPUS will be closed automatically.

Possible cause: Any severe OPUS system error, e.g. out of
memory/resources

Information on the error: Generally, Dr Watson pops up.

Standard log file path: * <\winnt\system32\drwtsn32.log

* \Documents and Settings\All Users\Applica
tion Data\Microsoft\Dr Watson (sometimes
in case of recent systems)

1 To find out which log file protocol path
applies for the OPUS system used (see
chapter 2.5.1.1), have a look at the Dr Wat-
son for Windows dialog.

Table 2.7: OPUS crash

2.5.1.1 How to find out the log file protocol path?

Open the Windows Start menu.

Select the Run command.

On the dialog that opens, enter drwtsn32.

Click OK to confirm.

> A dialog opens showing the log file protocol path.

Pobd =
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5. Click the Browse button to have the path structure displayed.
6. Click OK to confirm the settings made.
7. Send the log file to opusbugs@bruker.com.

2.5.1.2 Generating a crash dump file

Usually, it is advisable to create a crash dump file (with user.dmp as file name). This
type of file is very helpful in case of troubleshooting. The file requires, however, a lot
of disk space.

Open the Windows Start menu.

Select the Run command.

On the dialog that opens, enter drwtsn32.
Click OK to confirm.

On the dialog that opens, activate the Full option button to set the file display
size.

Activate the Create Cash Dump File check box.
Send the crash dump file to opusbugs@bruker.com.

ok wbd-=

N o
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3 Error during measurement

If OPUS shuts down, or the interface freezes during measurement, a full report has
to be generated (chapter 3.1), and the latest, still available measuring results have
to be saved (chapter 3.2).

3.1 Generating full report

The full report is a useful fault diagnostics tool. This report provides all the neces-
sary information about the instrument configuration and complete spectrometer sta-
tus.

This report also includes error messages, internal and external data transfer as well
as values of all relevant parameters. The full report is an important and - especially
if a problem or failure has occurred - indispensable tool for fault diagnostics by ser-
vice engineers.

3.1.1  Via the firmware page of the spectrometer

1 * Open the Web browser.
» Measurement Memus » Enter the spectrometer IP address
s Measurement Statns . .
« Direct Command Entry into the add_ress e_ntry field. _
+ Messages » On the configuration page, click Ser-
+ Diagnostics vice.
* Seryice
» Auth_ntication

Table 3.8: Generating full report
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2 e One Lol Back * Click the Full Report option.

« View Instrument Configuration > The current full report is dis-
« FullR:

" Logbumad! played.

L] BBE‘E

List of commands
T e

3 * On the File menu of the Web browser, click the Save as command.

+ Use the file extension *.htm.

+ Send the original htm file to opusbugs@bruker.com. Do not generate
any screenshots or text files.

Table 3.8: Generating full report

3 Save the full report immediately after a problem or failure has occurred. Otherwise,
important information will be overwritten by newer entries.

3.1.2 Viathe OPUS diagnostics page

1. On the Measure menu, select the Optics Diagnostics command.
2. On the dialog that opens, click the Send Report button.
> The report is sent to opusreports@bruker.com.
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3.2 Saving the latest measuring results

1 * Open the Web browser.

ﬁiwmmm‘ 1;’1@““5 * Enter the spectrometer IP address
easurement status : 3
Direct Command Enirv into the add_ress entry field. _
Messages » On the configuration page, click Ser-
Diagnostics vice.

Service

A tication

2 <2 @ Ea| Bl « Click the List of result data files
Wiew Instrumnent Confimuration Option.

: Full Report > The measuring result list is dis-

Log buffer
Beep p/ayed

o List of commands

o List of result data files | <——

* Soenial commands A

3 » On the File menu of the Web browser, click the Save as command.
* Use the file extension *.htm.

* Click the Save button.

» Send the measuring result list to opusbugs@bruker.com.

Table 3.9: Saving the latest measuring results
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4 Appendix

The appendix contains additional information for systems with the special WinDe-
bug tool installed.
1. Open the WinDebug tool.
2. Enter the following commands into the command line:
* LM (Enter)
+ KV (Enter)
* R (Enter)
+ U (Enter)
» DB (Enter)
3. On the Edit menu, select the Write Window Text to File command.
> A log file is created.
4. Send the log file to opusbugs@bruker.com.

For further information refer to: http://support.microsoft.com/kb/892277
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